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Model ST-260 Ratemeter 
 

 

Figure 1 ST260 

 
The ST260 Ratemeter combines many features 
into a single, inexpensive instrument. A large 
analog meter displays Counts per Minute (CPM) 
and Counts per Second (CPS), as well as the High 
Voltage set point for the Geiger-Mueller detector. 
The ST260 may be interfaced to a computer via 
USB and displays information using the included 
Spectrum Techniques STX software on both PC 
and Macintosh OSX computers. 

The ratemeter function is ideal for laboratory 
contamination survey work. Classroom 
demonstrations and nuclear experiments can 
be viewed directly from either an IBM-PC 
compatible computer running Microsoft 
Windows or Macintosh computer using a USB 
interface. The provided software renders all of 
the ST260’s information visible from the PC 
and allows real-time data transfer to the 
computer. This data can be stored in 
spreadsheet compatible files allowing data 
analysis and graphical presentation using 
many common spreadsheet programs, such as 

Microsoft Excel or Open Office Spreadsheet.  
The preset Time, Pause Time, and Number 
of Runs functions are available when 
connected to a computer and enable the user 
to acquire radioactive events for a 
predetermined number of seconds. This is 
useful for accurately comparing radioactive 
sources and teaching plateaus in GM 
counters. Plotting GM detector plateaus may 
be done if the high voltage is manually 
incremented. 

The ST260 has a BNC connector and a 
precision high voltage supply that is adjustable 
from 0 to +1200 volts. This supply provides 
0.2mA at 1200 volts, making it suitable for many 
types of GM tubes. The ST260 operates on 
internal, rechargeable NiMH batteries and also 
includes a 9-volt AC power supply. The unit may 
be used and the batteries recharged while 
operating on the AC power supply. 
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Specifications  
GM Input: BNC connector; Accepts standard Geiger-Mueller tubes.  

High voltage: 0 to +1200 volts @ 0.2mA, continuously variable by front panel HV ADJUST control.  

Display: 4 1/2” analog meter display, CPS, CPM and HIGH VOLTAGE. 
 
Modes: Counts per Second (CPS), Counts per Minute (CPM) and HIGH VOLTAGE front panel 
display. When connected to a computer, the ST260 offers: Scaler Counts; Digital Count Rate, Analog 
Count Rate, Preset Time, Pause Time, Elapsed Time; Runs Remaining; High Voltage. 

Audio: VOLUME ADJUST by front panel control; Audible indication of radiation events. 

Interface: USB, for both PC and Macintosh computers. 

Power: 9 volt DC, at 500mA* and internal, rechargeable NiMH batteries. 

Dimensions: 10” W, x 8” D, x 4.25” H  

Software: STX software for Windows and Macintosh OSX  both on CD  
Caution: Use only the AC adapter included with the ST260 if you are not operating on 

internal battery power. Using a different adapter can damage the unit and void 
the warranty. You may operate the unit and simultaneously charge the 
batteries by using the AC adapter. 

 

Controls & Indicators 

Below is a brief description of the ST260 controls and indicators.  

FRONT PANEL 
OFF, HV, X1, X10, X100, X1000 Control  

Turning the ST260 to the HV position allows adjustment of the High Voltage bias to the 
Geiger-Mueller detector. (Adjustment is by means of the HV ADJUST control, below.) 
X1 through X1000 switch positions scale the count rate by a factor of 1 through 1000 
depending upon which switch position is selected.

 
HV ADJUST Control  

Allows adjustment of the High Voltage bias to the Geiger-Mueller detector to be from zero to 
+1200 volts. This bias voltage is indicated on the panel meter and also on the computer 
screen if the instrument is connected via the USB. 

VOLUME ADJUST Control  
Speaker volume is adjusted between MIN and MAX with this control.  
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BATTERY Indicator  
Tri-color LED shows GREEN, YELLOW or RED depending upon rechargeable NiMH battery 
conditions. A bar graph and percent charge remaining readout is present at the top of the 
computer screen if the ST260 is connected via USB. 

 
Figure 2 ST260 Rear Panel 

REAR PANEL 
GM INPUT  
BNC connector accepts standard BNC to BNC cables. Provides power to and accepts signals 
from GM detectors. 

+9V  
AC Power input connector; accepts +9 volts from AC transformer, 115/220 volts ac input. 

USB 
Standard Female A connector; accepts Male A connector to Male B connector cable that 
connects the ST260 to computer. 
 
 

Operating Modes  

Below is a description of each mode. The standalone-operating mode is probably the most 
common and it will be discussed first.  

RATEMETER Mode 
 

The ST260 may be used as a standalone ratemeter, displaying counts as both counts per 
second (CPS) and counts per minute (CPM). Front panel controls and adjustments include 
High Voltage and speaker Volume Adjust. A BATTERY level indicator glows GREEN, 
YELLOW or RED to indicate relative level of battery function remaining. 
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HIGH VOLTAGE Mode  
This mode is for displaying, or setting, the high voltage level. The high voltage is 
continuously variable and can be set to any value between 0 and 1200 volts.  

In the computer-operating mode, there are many more options available. These include the 
following: 
 
SCALER COUNTS Mode  

The SCALER COUNTS mode is for displaying the number of radioactive events, or counts. 
During data acquisition, the display will increment in real time.  

 
DIGITAL COUNT RATE Mode 
 

In the DIGITAL COUNT RATE Mode, a small, independent window appears on screen that 
indicates the number of radioactive events in either CPS or CPM, depending upon which is 
selected. 

 
ANALOG COUNT RATE Mode 
 

In the ANALOG COUNT RATE Mode, a small, independent window appears on screen with 
an analog meter that indicates the number of radioactive events in either CPS or CPM, 
depending upon which is selected. The scale factor may be selected as X1, X10, X100, 
X1000 or Auto Scale. 

 
PRESET Mode  

The PRESET Mode allows the user to preset Time, Pause Time and Number of Runs. The 
Preset Time function will allow the user to automatically count radiation events for a 
predetermined amount of time. To engage the Preset Time function, select the TIME Preset 
from the drop down menu. Set the value desired from the resulting menu. The Preset Time is 
always visible in the upper right-hand corner of the main window. After counting for this time 
value, counting will automatically stop. To stop the Preset Time function, set the preset time 
to zero.  

The Pause Time is also selected from the PRESET drop down menu. This feature pauses 
the ST260 counting for the selected number of seconds to allow adjustment of high voltage, 
recording counts for later use, or other desirable pauses. Setting is similar to Preset Time, 
using the Set Pause Time, type the number of seconds you desire to pause counting in the 
box and click OK.  
 
The Number of Runs sets the number of times the ST260 will count for the preset Time, 
pause for the selected Pause Time and repeat this cycle. The Number of Runs function is 
useful for determining the GM plateau by automatically repeating counting cycles, allowing 
the user to increment the High Voltage during the Pause Time, as chosen above. 
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ST260 Software Installation and Operation 
Microsoft Windows Version  

Introduction  

NOTE: The STX software should be installed BEFORE 
connecting the instrument to the computer! 
 
The supplied STX software provides full readout of the ST260 information from an IBM 
compatible PC or Macintosh computer. It allows the user to save data to the PC and to use the 
features described in the Operation section below. The latest STX software revisions are 
available on our web site at www.spectrumtechniques.com.  
 

Installation  

Place the installation CD into the CD-ROM drive or download the STX software from the 
web site. In the case of the CD, the window, below, should appear. If it should not appear, 
open Window’s Explorer, open the CD to inspect its contents and double click on the 
“Software” folder. Follow the instructions as below. This menu will not appear if the 
software has been downloaded from the Spectrum Techniques web site. 

 

 

Figure 3 SpecTech CD menu after insertion 
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After double clicking the Software folder, you should get the following screen. 
 

 

Figure 4 View after opening the "Software" folder 

Double click the ST260 folder and you will see the following screen. 
 

 
Figure 5 After opening the ST260 folder 
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Double click the Software folder and verify you see the following screen. If you have downloaded 
the STX software from the Spectrum Techniques web site instead of installing it from the CD, you 
will see the following message. If so, click “OK” to continue Installation. 
 

 
Figure 6 Contents of "Software" folder 

Select Run. The Wizard will proceed to the next display.  

 
Figure 7 Security warning 
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You will have the opportunity to install Java. If it is already installed on your computer, you may 
cancel Java install; otherwise, click Setup. 
 

 

Figure 8 Java and STX Software Setup 

Java Installation screen: 

 

Figure 9 Java Installation Screen 
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STX software Installation screen. Just follow the prompts until the software installation is 
complete. 
 

 

Figure 10 STX Software install 
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When you first connect the ST260, or any of the STxxx series of instruments to the computer 
after you have installed the STX software, you will get the following “Found New Hardware” 
Wizard. The following screens are taken of a ST360 installation and the ST260 procedure will be 
the same. 
 

 

Figure 11 Add New Hardware 

Select Search for the best driver for your device, and Next. The Wizard will proceed to the next 
display.  

 

Figure 12 Add New Hardware, Step #2 

Select CD-ROM drive and Specify a location. Verify that the text box is displaying the correct path 
to the CD-ROM drive and select Next. (NOTE: In this example the CD-ROM drive is shown as 
"E". However, it may be a different letter depending on the configuration of the user’s PC). The 
following display will appear when Windows has found the correct driver on the installation CD.  
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Figure 13 Add New Hardware, Step #3 

Select Next. The Wizard will proceed to the next display, indicating that driver installation is 
complete.  

 

Figure 14 Finish 

Select Finish to end installation. Run the ST260 software by double-clicking on the desktop icon. 
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Operation 
 

When the ST260 program opens, it defaults to the Scaler view, with the title bar reading ST260 
USB - -[Data Window] or ST260 Serial - -[Data Window].  

 

Figure 15 Default STX Counting Screen 

In the upper part of the main display are the menu headings. From left to right, they are: File, 
Edit, Setup, View, Preset, Experiments, and Help. Menu selection is either by using the mouse 
or by holding the Alt key and pressing the key corresponding to the underlined letter in the title’s 
name. Note that grayed out menu headings do not apply to the ST260. 

Below the menu titles are icons for running commands. From left to right, they are File Open, 
File Save, Print, Start, Stop, and Erase.  

Under the icon row are sections displaying various data and settings. The sections include 
Counts, Data, Preset Time, Elapsed Time, Runs Remaining, and High Voltage.  
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Menus 
This section describes the menus and their contents. The menus are File, Edit, Setup, View, 
Preset, Experiments, and Help.  

File  
The File menu contains Open, Save, Save As, Print, Print Setup, and Exit.  

 

Figure 16 The File menu options 

Open  
Open allows the user to open a previously saved file with the .tsv extension and display it in 
the Data section of the main display. Once a file has been opened, any additional data 
acquired will automatically append itself to the end of the list. 

 
Save / Save As  

Save allows the user to save the current data displayed in the Data Section. If the data has 
been previously saved, it will be saved with the same file name. If the data has not been 
previously saved, it will prompt the user for a file name and allow selection of a different 
directory. Save As always ask for a file name, whether or not the file has been previously 
saved. The file is always saved in the .tsv version that can be opened in database 
spreadsheets such as Microsoft Excel. 

 
Print / Print Setup  

Print opens the standard Windows printer dialog box allowing the user to select the printer 
properties, printing range, and the number of copies. Selecting OK will print the description, 
number of runs, preset time, pause time, alarm level, high voltage setting, counts, date, and 
time. Print Setup will open the standard Windows dialog box, allowing printer configuration.  

Exit  
Selecting Exit will close the program.  
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Edit  

The Edit menu contains the Copy selection.  
 

 

 
 
 
 

Figure 17 Edit option

 
Copy  

Copy is the only selection in the Edit menu. It allows the user to copy the description, number 
of runs, preset time, pause time, alarm level, high voltage setting, counts, date, and time to 
the Windows clipboard. Afterwards, the user can paste the data into another application. 

Setup  
The Setup menu contains ReSync and it is only available when communication is established 
via the USB.  

 

Figure 18 Setup option 

ReSync  
If communication is lost between the ST260 and the PC, click on ReSync to re-establish it. 

View  
The View menu contains the two main views of the ST260: Digital Rate Meter, and Analog Rate 
Meter. It also gives the option of displaying CPS or CPM and Scaler Counts, Digital Count Rate 
and Analog Count Rate. 
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Figure 19 View Options of ST260 

Digital Rate Meter  
Selecting the Digital Rate Meter opens a small, independent Digital Rate Meter window that 
displays either CPS or CPM, depending upon what is selected.  

 
Figure 20 Digital Rate Meter Option 

 
 
Analog Rate Meter  

The Analog Rate Meter view simulates an analog meter by displaying a meter and a moving 
needle. Users accustomed to analog meters will find this view helpful. The meter range is 
selectable and also features an auto-ranging scale. As with the Digital Rate Meter view, the 
Analog Rate Meter view displays the count rate in counts-per-second or in counts-per-minute.  

 

 
Figure 21 Analog Rate Meter Option 

 
The figure below shows all three views displayed simultaneously.  
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Figure 22 Main ST260 Window with Digital and Analog Rate Meter showing

 
Preset 
The Preset menu allows certain parameters to be set before counting takes place.  

 

Figure 23 Preset Options 
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Preset Time  
Preset Time opens a box that displays the available preset time settings in seconds. The 
setting range is from 0 to 900,000, with 0 being OFF. To change the setting, select a number 
and click OK. When the preset count setting is reached, the counting will stop.  

 

Figure 24 Preset Time Setting 

The Preset Time is always visible in the upper right-hand corner of the main window.  

 

Figure 25 Preset Time from right-hand-corner of main window 

 
Pause Time 

Pause Time is used in conjunction with Preset Time and Runs. It causes the counting to 
pause for a predetermined number of seconds between runs. When Pause Time is selected, 
the following box appears. Enter the time in seconds.  

 

 

Figure 26 Pause Time Setting
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Runs  
When Runs is selected, the following box appears.  

 

Figure 27 Set Number of Runs 

Enter the number of runs and click OK. When used in conjunction with Preset Time, this 
feature causes counting to automatically repeat after the unit counts for the preset time. Once 
all the runs have been executed, the counting will stop. During this operation, the Runs 
Remaining section of the main view displays the remaining runs.  

 

Figure 28 Runs Remaining from main window 

 

Experiments 
The Experiments menu allows the user to create a graph from the ST260’s counts, such as 
demonstrating a GM plateau with counts vs. bias voltage.  

 

Figure 29 Experiments Menu 

 
Help  
The Help menu provides immediate help for the user. To utilize the help feature, select Help and 
the topic you wish to view.  
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Command Icons  

 

Figure 30 Command Icons 
File Open, File Save, and File Print  
The first group of icons from the left is the File Open, File Save, and the File Print icons. The File 

Open icon functions exactly like the Open command in the File menu.  The File Save icon 

functions exactly like the Save command in the File menu. The File Print icon functions exactly 

like the Print command in the File menu. 

 
Count, Stop, and Erase  
The second group of icons consists of the Count, Stop, and Erase icons. The Count icon starts 

counting on the ST260. The Stop icon functions stops counting. The Erase icon erases all the 

data in the data section. However, as a safety precaution it will prompt the user to save the 

current data before deleting it.  

 
Graph 
 
The Graph function icon allows the user to create a Graph based upon either Counts and 
Voltage, such as a GM plateau or Counts and Runs. See menu, below. 
 

 
Figure 31 Create Graph Options 

 
Note: If any of the icons are grayed out, it means they are not available at that particular 
time. In the example below, the File Save, File Print, and Stop icons are grayed out. This is 
because the Data section contains no data to save or print, and the ST260 is already in 
STOP mode.  
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Figure 32 Showing Icons grayed out

 
Information Display Sections:  
As the illustration below shows, the main display has 7 sections for displaying information: 
Counts, Data, Preset Time, Elapsed Time, Runs Remaining, HV, and Step. (Note that the Step 
function is not available in the ST260 and the option will not display on the screen.) 
 

 

Figure 33 Typical Data Window 

Counts Section  
The Counts section displays the total number of counts. 

 
Data Section  
The Data section displays information for each data acquisition. This information includes Run, 
HV (high voltage setting), Counts, Elapsed (time in seconds), Date, and Time. This is the actual 
data that is stored when using the Save command. 
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Preset Time Section  
The Preset Time section displays the current Preset Time setting. 

Elapsed Time Section  
The Elapsed Time section displays the time elapsed during counting. The elapsed time will 
reset to 0 when either the data is erased or when counting is re-started after the end of a preset 
time. If the preset time is not set, or counting is interrupted with the Stop command, the elapsed 
time will not reset and will resume running when Count is selected again.  

Runs Section  
The Runs Remaining section displays the remaining number of runs set by the Runs setting.  

HV Section  
The HV section displays the current high voltage setting. 
 
 
Step Section  
The Step window displays the high voltage step size and is only visible when the step voltage 
function is available and set. 
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System Operation 
Basic GM Tube Setup and Operation  

Warning!  
Dangerous voltages can exist at the GM connector. Ensure that the high voltage is set 
to zero or that the instrument is OFF before connecting or disconnecting a detector.  
1. Connect the ST260 to its AC adapter.   
2. Connect a GM tube to the GM INPUT connector via a BNC cable.   
3. Set the HIGH VOLTAGE to the recommended value for the GM tube by the front panel HV 
ADJUST control.  
4. Place the radioactive source close to the GM tube’s window.   
5. Using the Operating Mode information described above, set the unit up to perform the 
desired function.  
6. Click the COUNT icon to start data acquisition, the STOP icon to halt data acquisition 
(providing Preset Time is not being used), and the RESET icon to clear the data and reset 
the time and data to zero.  

 

GM Tubes  
Geiger-Mueller tubes produce electrical pulses when ionizing radiation events occur within their 
sensitive volume. For proper operation, only run these detectors at the manufacturer's specified 
voltage. If this voltage is not known, then it must be derived empirically by plotting a plateau 
(see below). To improve sensitivity to alpha and beta particle radiation, many GM tubes have 
extremely thin entrance windows made of mica or other materials, which require considerable 
care in handling. Do not remove protective caps unless necessary and never touch the 
window. 

 

GM Tube Plateau  
The correct operating voltage for the Geiger-Mueller tube may be determined experimentally 
using a radioactive source such as Cs-137 or Co-60. A properly functioning tube will exhibit a 
"plateau" effect, where the counting rate remains nearly constant while the high voltage is 
increasing linearly. A plateau chart is obtained by using a constant preset time to count a 
source for several runs, while increasing the high voltage by some constant amount after each 
run. This process is described in detail in the next section, Creating a Plateau Chart. 
 

Creating a Plateau Chart  

Running the unit as stand-alone  
1. Place the radioactive source in a fixed position close to the GM window.  
2. Turn on the ST260 and slowly increase the high voltage until you observe a count rate 
increase from the ST260.  
3. Increase the voltage by 20 volts and count data again.  
4. Repeat step 3 until the high voltage reaches its upper limit (this is determined by the 
upper operating voltage limit of the detector).  
5. Create an X-Y graph of the data, with “Y” being the Counts, and “X” being the voltage, 
and plot the chart.  
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Using the ST260 Software  
1. Place the radioactive source in a fixed position close to the GM window.  
2. Turn on the ST260 and slowly increase the high voltage until the meter indicates an 
increased count rate. This is the starting voltage.  
3. Determine the upper operating voltage limit of the detector. This is the ending voltage.  
4. Subtract the starting voltage from the ending voltage. Divide the result by the high 
voltage step size that you want to use (20 volts in this case). This will yield the number of 
runs.  
5. Select High Voltage Setting in the Setup menu and set the High Voltage to the starting 
voltage.  
6. Select Preset Time in the Preset menu and set it to 10 seconds. Set the Pause Time to 
5 or 10 seconds, or whatever delay you will need to write down the counts and high 
voltage and then manually increase the voltage by the step size you selected in step 4.  
7. Select Runs in the Preset menu and set it to the number calculated in step 4.  
8. Start data acquisition. Manually increase the High Voltage during the Pause Times to 
the next level. Record results. After counting has begun, it will automatically stop when 
runs equals zero.  
9. Save the data to a file. Before saving, a description of the data may be entered into the  
Description box.  
10. Open the saved file version with a .tsv extension into a spreadsheet program such as 
Microsoft Excel.  

 
The following illustration shows a typical detector plateau.  

 
Figure 34 Typical GM Plateau 

Notice that the counts form a relatively flat place on the graph between 850 and 1100 volts. The 
center of this area, at approximately 1000 volts, is the recommended operating voltage for the 
detector. However, any voltage in this flat region would be acceptable. Also, notice that the 
counts increase rapidly as the high voltage nears its upper limit. This indicates that the tube is 
entering its breakdown region. Do not continue to operate the tube in this region. 
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Resolving Time 
Geiger-Mueller tubes exhibit dead time effects due to the recombination time of internal gas ions 
after an ionizing event occurs. The actual dead time depends on several factors including the 
active volume and shape of the detector. Dead time can range from a few microseconds for 
miniature tubes, to over 1000 microseconds for large volume devices.  

When making absolute measurements it is important to compensate for dead time losses at 
higher counting rates. If the resolving time of the detector is known, the true counting rate may be 
calculated from the measured rate using the following expression:  

n= m/1-mt  
where n is the true counting rate, m the measured rate, and t the detector resolving time.  
If the detector resolving time is unknown, it may be determined experimentally using two 
radioactive sources. Maintaining constant counting geometry is important throughout the 
experiment. A special source split into two halves (Spectrum Techniques part # RSS2) is 
available for making the measurement, but good results may be obtained by careful 
positioning of two standard check sources. Perform the following steps to calculate the 
resolving time:  

1. Turn on the ST260.  
2. Position the two sources (a+b) side by side and close enough to the GM tube’s 
window to obtain a count rate of at least 10,000 CPM.   
3. Record the count rate as R(a+b).  
4. Remove source (b) and record the count rate as R(a).  
5. Carefully replace source (b) to its original position, remove source (a) and record the 
count rate of source (b) as R(b).  

 
Solve for the resolving time using this equation              T= [R(a)+R(b)-R(a+b)] / [2R(a)*R(b)] 

The resolving time of the ST260 RATEMETER is very short and is not a significant factor 
compared to that of the GM tube. 
 

Warranty and Repair Information  
Spectrum Techniques warrants products of our manufacture against defects in workmanship or 
material for a period of one year from date of shipment. We will repair or replace, at our option, 
any instrument that is deemed defective during this time. This warranty covers all replacement 
parts and labor. The instrument must be returned to our factory prepaid and we in turn will pay 
the cost of the return shipping.  

The warranty does not cover damage caused by mishandling or misuse. GM tubes with broken 
windows are specifically excluded from this warranty. Accessory items not manufactured by 
Spectrum Techniques but supplied as part of our systems will be subject to the original 
manufacturer’s warranty.  

For warranty-repair information or return authorization, contact customer service at:  
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